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Editing Digital Images 
Adobe Photoshop Elements (4.0) 

 
 
THE PROGRAM  
 
We will use a very capable program called Adobe Photoshop Elements 4.0. It contains 
most of the basic features of Adobe Photoshop CS and more.   We want to begin by 
learning how to edit and enhance photos. 
 
EXPLORING EDITING AND ENHANCING MODE 
 
Open Photoshop Elements.  This is a very complex window due to the enormous 
capability of the program.  
 
The screen has a Title Bar which always displays the name of the program and in this 
case also the mode “Editor”, a Menu Bar which contains drop down menus with all of the 
functions needed to edit images.  
 
Below the Menu Bar is the Shortcuts Bar with quick shortcuts for a few frequently used 
functions. At the left end of that Shortcuts Bar are two tabs to enable you to switch back 
and forth between Full Edit and Quick Fix. If Full Edit is not selected (lighter in color) 
position the mouse on Full Edit and click.  
 
Below the Shortcuts Bar we see the Options Bar which contains the specific settings for 
the active tool. The Options Bar changes to match the tool currently selected.  
 
On the left is a Toolbox which houses the various tools we will use. 
 
Now let’s make sure the Palette Bin and Photo Bin are properly configured.  
On the right is the Palette Bin which holds palettes that provide information used in 
editing. 
 
If the Layers Palette is not visible, go to Window on the Menu Bar and slide down to 
Layers and click. 
  
If on the right side of your screen you can see the Layers Palette in the Palette Bin and if 
the triangle beside the word Layers points to the right, click on this arrow and the Layers 
Palette will be expanded. Lets close the How To Palette and the Styles and Effects 
Palette by clicking on the triangle pointing down. 
 
At the bottom of the window, in the area Windows calls the Information Bar, is the Photo 
Bin where thumbnails are stored for all open images  
 
As we work with Elements we will see many different personalities (different icons) of the 
mouse. 

 
CROPPING (Guest and Ricardo.jpg) 
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For this exercise we’ll work with the file “Guest and Ricardo”. Position the mouse on the 
word File on the Menu Bar and click. Slide down to Open and click. The file we want is in 
the My Pictures folder in the My Documents folder.  Position the mouse on the file Guest 
and Ricardo and double click to select and open the file.  
 
Fit On Screen 
 
Position the mouse on the Hand Tool and click. Position the mouse on the Fit Screen 
button on the Options Bar and click. Now we can see the image well.  
 
Now the first thing we notice is both people have red eye. That is the reflection of the 
flash off the blood vessels in the back of the eye. Most digital cameras have a red eye 
reduction feature but it doesn’t always eliminate red eye. People with fair complexions 
like blonds and red heads exhibit redder eyes than brunettes or people with dark 
complexions. Young children and pets usually display a lot of red eye. Pets sometimes 
display green eye.  
 
Cropping  
 
We want to select a portion of this image to save. This is called cropping.  
 

Position the mouse on the Crop Tool ( ), midway down in the Toolbox and click. With 
this tool we can select a rectangular head and shoulder portion of the blond to keep and 
discard the remainder of the image.  
 

Position the mouse ( ) at the upper left of the rectangular area you want to select and 
drag to the lower right until you have the rectangle selected. When you release the left 
button you notice two things. First the portion you will be discarding is darker than the 
portion you will be saving. Second, little handles appeared. We can drag on any of the 8 
handles to adjust the selection. We can also position the mouse anywhere inside of the 
selection and move the entire selection.  
 
Adjust your selection so you have a really nice head and shoulder composition. You’ll 
notice a small rectangle below the selection containing a green check mark and a red 
“not” symbol. These buttons are useful to either accept the crop or stop and start over.  
Click the check mark to finish the crop. 
 
Position the mouse on the Hand Tool and click. Position the mouse on the Fit Screen 
button on the Options Bar and click. Now we can see the image well.  
 
 
Zoom In 
 
Let’s zoom in to see the actual pixels. Position the mouse on the Zoom Tool, (it looks 
like a magnifying glass), in the Toolbox, and click. Every time we select a tool, the 
Options Bar, just below the Shortcuts Bar, shows the options for that tool. Now the 
Options Bar contains options for the Zoom Tool. It is important that the magnifying glass 
with the + in it, is selected (has the box around it). If this isn’t true, position the mouse on 
the magnifying glass with the + sign and click.  
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Now let’s zoom in all the way until we see the pixels. Click 6 times on the image, 
continually positioning the magnifying glass on her right eye. Each click will zoom in 
closer to the actual pixels. Now you will see the actual little square pixels. Note that each 
is a different color. Also notice that a Scroll Bar has been added to the right and bottom 
edges of the image, as we can no longer see the entire image.  
 
RED EYE REPAIR (Guest and Ricardo.jpg) 
 

We will use the Red Eye Removal Tool to fix the red eye problem. Select this tool ( ) 
from the Toolbox (it looks like an eye with a plus sign beside it). Move the cross hair 
pointer to the red area of the eye and click.  
 
Now let’s snap back out to see the result. Position the mouse on the Zoom Tool, and 
click. Now position the mouse on the Fit Screen button on the Options Bar and click. Her 
right eye looks much better.  
 
To save your cropped file go to the File Menu and choose Save As.  The Save As dialog 
box will appear.  Check the Save in: box.  This tells you which folder you are using to 
save the file.  Click the small down arrow at the right end of the box to change the folder 
location.  We will leave the location as My Pictures. 
 
On the lower part of the screen you will see the File Name: box.  If you keep the same 
file name it will overwrite your original file.  This is often a bad idea.  If you overwrite you 
can never go back and recover the original picture.  You need to develop some file 
naming scheme such as adding a number, letter, or date to the original file name. 
 
Be sure the format of the file is set to JPEG(*.JPG*.JPEG*.JPE) and click on the Save 
button.  The JPEG Options dialog box will appear.  If you are going to email this file you 
can set the Quality on Low or Medium.  If you are going to print the file use High or 
Maximum.   Click OK. 
 

  
LIGHTEN PART OF AN IMAGE (Parrot.jpg) 
 
Position the mouse on the word File on the Menu Bar and click. Slide down to Open and 
click. Position the mouse on Parrot and double click to select and open the file. It is 
always a good idea to fit the image on screen. Position the mouse on the Hand Tool in 
the Toolbox and click. Position the mouse on the Fit Screen button on the Options Bar 
and click.  
 
Notice the bright background of this image makes the detail all very dark.  Try the 
automatic options under the Enhance menu on the Menu Bar.  None of them are quite 
right.  We will use the Shadows/Highlights command to fix this image.  
 
Position the mouse on Enhance on the Menu Bar and click. Position the mouse on 
Adjust Lighting on the pull down menu, then on Shadows/Highlights and click.  
If this window is on top of our image, position your mouse on the title bar of the 
Shadows/Highlights window and drag and drop (left mouse button down) this window to 
the side so we can see the changes to the picture.  
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Drag the Lighten Shadows slider to the right to about 70. Shadows/Highlights brightens 
the dark areas (the bird and branches) without washing out the bright area (the sky). 
Click OK to accept the change.  
 
Close “Parrot”. Position your mouse on the X and the right end of the Parrot title bar and 
click no to Save.  
 
STRAIGHTEN AN IMAGE (Sloping Horizon.jpg) 
 
A very common image problem is a sloping horizon. This is particularly true for images 
taken from a ship or from the shore where the horizon is very conspicuously crooked.  
Position the mouse on the word File on the Menu Bar and click. Slide down to Open and 
click. Position the mouse on Sloping Horizon and double click to select and open the file. 
As you can see, this is a nice image but it is “running downhill”.  
 
It is always a good idea to fit the image on screen. Position the mouse on the Hand Tool 
in the Toolbox and click. Position the mouse on the Fit Screen button on the Options Bar 
and click.  
 
Adobe Photoshop Elements has a feature that will insure you are able to straighten the 
image so it is perfect. Position your mouse on the Straighten Tool in the Toolbox 
(halfway down and under the yellow star) and click. On the Options Bar for this tool you 
will notice the first field is set for “Grow or Shrink Canvas to Fit’’, click on the pull down 
beside this field and choose “Crop to Remove Background” and click. 
 
Position the mouse anywhere on the horizon and drag your mouse horizontally along the 
horizon about 2 inches from where you started.  By choosing the option “Crop to 
Remove Background” your image will be straightened and will be cropped automatically 
once you release your mouse.  
 
Bravo, you now have an image with a level horizon. Position the mouse on the X at the 
right end of the Image Title Bar and click no to Save changes.  
 
REMOVING UNWANTED ITEMS (Cabo.jpg) 
 
How often have you taken a picture and noticed later that there is a phone line right in 
the middle?  Today we will learn how to remove unwanted items from an image and 
replace them with the background that would otherwise be there. 
 
Now let’s open the image to work on. Position the mouse on the word File on the Menu 
Bar and click. Position the mouse on Cabo and double click to select and open the file. 
 
It is always a good idea to fit the image on screen. Position the mouse on the Hand Tool 
in the Toolbox and click. Position the mouse on the Fit Screen button on the Options Bar 
and click.   
  
This is a great picture of Cabo San Lucas taken from the top of a ship. But unfortunately 
there is a line in the way that distracts from the picture. We will now remove that line, 
replacing it with the appropriate background.  
 
Clone Stamp 
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In the Toolbox (just over halfway down) there is a tool called the Clone Stamp Tool. It 
looks like a rubber stamp. Position the mouse on the Clone Stamp Tool and click.  
 
Again, as when we select any tool, an Options Bar, appears below the Shortcuts Bar. It 
contains controls and options for the Clone Stamp Tool. Here we see the Clone Stamp 
Tool icons (Clone Stamp and Pattern Stamp), followed by the Brush Presets, Brush 
Size, Mode, Opacity, Aligned and Sample All Layers. We will be working with the Clone 
Stamp Tool. The only option we want to change from the default is the Brush Presets. 
  
Position the mouse on the Show Selected Brush Presets icon (looks like a worm) pull 
down and click. We can select many different sizes and types of brushes. With a smaller 
size brush we will have to stamp the line more times, but the seam will be less visible. 
We want size 19, so scroll down and position the mouse on Hard Round 19 pixels and 
click. We can get rid of a pull down menu by clicking on the down arrow that brought it 
down. So let’s do that now.  
   
We could have selected a Soft Round shape or even a Spatter shape. It depends on the 
pattern we want to clone. For example, with a solid pattern we would choose a hard 
brush. 
  
If your mouse is not a round circle, you may have the Caps Lock on.  
 
Define Clone Stamp Source  
 
The start of using this tool is critical. The relative position of the first source to the first 
target area will be remembered as we continue cloning.  
 
Now we will select the initial source area. This is the first area we want to copy on top of 
the line. Position the mouse in an area just two brush widths to the left of the bottom of 
the line.  
 
Press and hold down the Alt Key on the keyboard. Notice that the mouse personality has 
changed (it looks like a circle with a cross-hair in the center). While holding down the Alt 
Key, click to establish the area you want as the source. Now release the Alt Key on the 
keyboard. This defines the color and texture of the source.  
 
Position the mouse immediately to the right (horizontally) on the line and hold the left 
mouse button down. Notice the + sign, indicating the source area and note the change 
you made. Release the left mouse button. This also establishes the relationship between 
the source and target areas. This relationship will be maintained as we clone up the line.  
 
Now drag the mouse up the line, releasing the left mouse button several times, until you 
are almost on the beach. Notice the cross-hair, following along left of the brush, as you 
drag. That indicates the source area of each clone value. Note that the cloning operation 
matched the texture and color of the ocean to the left of the line as it replaced the line. 
  
The reason why we stop several times is in case we make an error and need to step 
backwards, we won’t have to start from the beginning.  
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When we get to the beach we will have to define a new source area or we will have 
water on the beach or sand in the water. If you have cloned water on to the beach we 
may have to use the Undo Option on the Edit Menu to remove it. Let’s zoom in to show 
the beach area in detail so we can see the rope on the beach clearly.  
 
Position the mouse on the Zoom Tool in the Toolbox and click. Now the Options Bar 
contains options for the Zoom Tool. It is important that the magnifying glass with the + in 
it is selected (has the box around it). If this isn’t true, position the mouse on the 
magnifying glass with the + sign and click. Place your mouse on the line on the beach 
and continue to click until you can clearly see the rope on the beach, about 4 times.  
 
Position the mouse on the Clone Stamp Tool, about half way down the tool box, and 
click. Note that the brush is huge because we have zoomed in. Remember the brush 
was set to a number of pixels.  
 
Select an area just to the left of the line on the beach and Alt/click to select the initial 
source. Carefully position the mouse on the line on the beach and drag it up and down to 
the ends of the line, watching the cross-hair to insure it remains on the sand.  
 
Remember if you make a mistake you can use the Edit Menu option of Undo to undo 
your last step. Let’s look at our corrected image. Position the mouse on the Hand Tool in 
the Toolbox and click. Position the mouse on the Fit Screen button on the Options Bar 
and click.  .  
 
As you see you can fiddle with this for hours. The more you practice this newfound skill 
the more adept you will become at cloning. We have more images to fix up so let’s move 
on.  
 
Position the mouse on the X at the right end of the Image Title Bar and click.  Click No to 
the save question. 
 
MORPHING (Two Tough Guys.jpg) 
 
Now let’s bring up an image and morph the face of one person onto another person.  
Position the mouse on the word File on the Menu Bar and click, slide down to Open and 
click. Position the mouse on Two Tough Guys and double click, select and open.  
Position the mouse on the Hand Tool in the Toolbox and click. Position the mouse on 
the Fit Screen button on the Options Bar and click.   
 
Here we see a picture of Mary standing next to the DMZ guard in Korea. We are going to 
put Mary’s face on the guard.  We want only the head and neck of Mary. We’ll use a new 
tool, the Lasso Tool. Position the mouse on the Lasso Tool, about a third of the way 
down (it looks like a cowboy’s lariat).  
 
Again (as always) an Options Bar shows up with parameters for the Lasso Tool. Verify 
the tool selected on the Options Bar is the first one, the Lasso Tool, and verify Feather is 
set to 0 pixels. 
 
Position the mouse (lasso) near Mary’s head and drag a loop around her head. Keep the 
left mouse button down until you have completed your loop around her head. Make sure 
to include her hair and neck. Once you have the loop closed, marching ants will appear 
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around your selection. Position the mouse on inside of the selection and Right Click 
(always gives you context sensitive choices). Position the mouse on Layer via Copy and 
click.  
 
If the Layers Palette is not open, click on the triangle beside the word Layers and this will 
open the palette.  
 
Notice in the Layers Palette we have created a new layer, Layer 1. The image in the 
Background layer still looks the same because Layer 1, with Mary’s head and 
transparent pixels, is positioned exactly on top of Mary’s head in the Background image. 
In the Layers Palette both layers have the eye in the Indicates Layer Visibility Box, which 
means that both layers are visible. Let’s turn off the visibility of the Background layer. 
Position the mouse on the Indicates Layer Visibility Box on the Background layer and 
click.  
 
Let’s use the Zoom Tool in the Toolbox to enlarge Mary’s head before we erase the 
unwanted pixels. Now the Options Bar contains options for the Zoom Tool. It is important 
that the magnifying glass with the + in it is selected (has the box around it). If this isn’t 
true, position the mouse on the magnifying glass with the + sign and click. Place your 
mouse on the Mary’s nose and continue to click until her head fills the screen. 
 
Position the mouse on the Eraser Tool in the Toolbox (looks just like an eraser about 
2/3rds of the way down) and click. Notice the Options Bar for the Eraser Tool. Position 
the mouse on the Show Selected Brush Presets down arrow and click (beside squiggly 
worm). Position the mouse on Hard Round 19 pixels and double click. 
 
Our objective here is to end up with only Mary’s hair, face, including her ear and neck. 
Drag the mouse  across the image removing unwanted portions. (If you do not have a 
circle, you have your Caps Lock Key on, and must press this key for your eraser to 
become a circle)  
 
During this process periodically release the left mouse button. Then continue erasing. 
This is important because, if you need to Undo (Step backwards, on the Edit pull down 
on the Menu Bar) you only go back to the last time you released the mouse. Continue 
cleaning up Mary’s head until all that is left is her head, hair and neck.  
 
Position the mouse on the Hand Tool in the Toolbox and click. Position the mouse on 
the Fit Screen button on the Options Bar and click.   
  
Let’s set the Indicates Layer Visibility Box back on Background layer in the Layers 
Palette. Position the mouse on the Indicates Layer Visibility Box on the Background 
layer and click. We can’t see anything different than before. That is because the Mary’s 
head (Layer 1) is exactly on top of her head in the “Two Tough Guys” image 
(Background layer).  
 
Position Head on Guard  
 
We will use the Move Tool and move the Mary’s head layer onto the Guards face. Layer 
1 should be the selected layer. Position the mouse on the Move Tool, (top in Toolbox) 
and click. Notice we should now see the Layer 1 handles from the bounding box around 
Mary’s head. If they aren’t there, click on Show Bounding Box on the Options Bar for the 
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Move Tool. Position the mouse on Mary’s face and drag it to the guards face. Position 
Mary’s face so her ear is on top of the guards’ ear.  
 
We’re getting close now. If Mary’s head was too small or too large we could drag one of 
the corners to change its size.  
 
We just covered up the Korean writing on the guard’s helmet. We need to erase some of 
Mary’s hair to reveal the writing. It’s like tucking Mary’s hair into the helmet. Position the 
mouse on the Eraser Tool in the Toolbox (looks like an eraser) and click. Now using 
dragging strokes, erase most of Mary’s hair. Continue erasing until you can see the 
writing and strap on the guards helmet. Be careful or Mary will have sunglasses on as 
well.  
 
The next step is to flatten the image. Position the mouse on word Layer on the Menu Bar 
and click. Slide your mouse down to Flatten Image and click. Notice in the Layers 
Palette there is now only one layer (Background).  
 
Now let’s crop the image to remove the original Mary and just keep “Guard Mary”. 
Position the mouse on the Crop Tool in the Toolbox (midway down), and click. Position 
the mouse on the image on the desired upper left corner, drag to the desired lower right 
corner and release the left mouse button.   There is a Commit Current Operation button 
at the bottom of the crop area. Click on the check mark to commit the crop. 
 
If you are having trouble finding a picture of your family where all are smiling (especially 
the small children) you might want to use this technique. You can also add a member of 
the family who wasn’t there for the original picture. 
 
At this point we have our finished image. Normally we would save it, probably in JPG 
format or print it out. This time let’s close the image. Position the mouse on the X at the 
right end of the Title Bar for the Two Tough Guys image and click. Say No to the Save 
question.  
 
PHOTOMERGE™ (Panorama) (Dmz - #1.jpg; Dmz - #2.jpg; Panorama Left.jpg; 
Panorama Right.jpg) 
 
Let’s create a panorama from multiple images. Many cameras have an option to create 
panorama sequences. Sometimes it is called Stitch. Special software really isn’t needed 
as Photoshop Elements can do it for you.  
 
Position the mouse on File on the Menu Bar and click. Then position the mouse on New, 
slide across to the right and click on Photomerge™ Panorama. Notice the Photomerge 
window. Now click the Browse button to find our files to merge. Double click DMZ #1, 
then Browse again and double click DMZ #2.  
 
We have selected two images taken at the DMZ between North and South Korea. Click 
OK and watch as Adobe Photoshop Elements does its magic. This is truly an amazing 
amount of computing to determine exactly how to place the two images!  
 
Note the Perspective and Normal radio buttons under the Settings in the right pane. 
Position the mouse on the Perspective radio button and click. After a short pause Adobe 
Photoshop Elements will apply the depth perspective to the new image. Position the 
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mouse on the Normal radio button and click. Before we click on OK to finish the 
Photomerge we have the option of keeping each image as a layer so we can still 
manipulate each image separately.  
 
Click OK to finish the merge. Be patient as the new image is assembled on the desktop. 
We could crop the image. Normally we would also edit the lighting, etc. Not today.  
Let’s close this image. Say No to the Save question.  
 
Position the mouse on the word File on the Menu Bar and click. Then position the mouse 
on New, slide across to the right and click on Photomerge Panorama. Click the Browse 
button to find our files to merge. This time we’ll select our images a different way. 
Position the mouse on Panorama Left and click. Now position the mouse on Panorama 
Right and while holding the Shift Key down and click. Both files are now selected. 
Position the mouse on the Open button and click.  
 
Both photos from the Miraflores Lock of the Panama Canal are now selected as source 
files for our Photomerge. Click OK and watch as Adobe Photoshop Elements does its 
magic.  
 
Note the failure to process. In that case, you will find the images residing at the top of 
your window in thumbnail format. Drag each image down separately, placing them in 
your workspace, and joining them as close as possible. When you have them 
overlapping enough the program snaps them into place.  
 
Of course, you could continue as before, also using Advanced Blending Options prior to 
Clicking OK. For now, let’s click cancel to terminate the process.  
 
CREATING A SIGNATURE LAYER – DorieSignature.jpg 
 
Take a digital photograph of your signature and download it to the computer.  Position 
the mouse on the word File on the Menu Bar and click, slide down to Open and click. 
Position the mouse on the signature file and double click to select and open.  
Position the mouse on the Hand Tool in the Toolbox and click. Position the mouse on 
the Fit Screen button on the Options Bar and click to have the file fill the available space 
on the screen.   
 
Click on the Magic Wand Tool in the Toolbox.  It is the seventh tool from the top.  In the 
Options Bar uncheck Contiguous.  Click  the Magic Wand Tool on the white space in 
your picture.  This will select all the white areas.  Click Select in the Menu Bar and click 
on Inverse.  This will unselect the white space and select the black signature instead. 
 
From the Layer Menu choose New, Layer via Copy.  You should see a new layer in the 
Layer Palette called Layer 1.  The gray and white checkerboard means the white areas 
are now transparent. 
 
Click on the File Menu, Save As, and save this file.  Type in Signature in the File name: 
box.  The Format:  should be Photoshop (*.PSD.*PDD).  Click the Save button. 
 
To add the signature layer to another file open both files in Photoshop Elements.  Be 
sure you can see both files on your screen.  Click on the Signature file to select it as the 
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active picture.  Position your mouse on Layer 1 in the Layer Palette.  Hold your mouse 
button down and drag and drop your signature onto the other file. 
 
To reposition the signature in the new file choose the Move Tool.  It is the top tool in the 
Toolbox.  Be sure Auto Select Layer box in the Options Bar is unchecked and the Show 
Bounding Box is checked.  Be sure the signature layer is selected in the Layer Palette.  
When you move your mouse into the box on your screen it becomes a 4-headed arrow.  
Hold your mouse button down and drag the signature to the desired position. 
 
If you need to resize the signature, be sure the signature layer is selected in the Layer 
Palette.  Select the Move Tool from the Toolbox.  Position your mouse over one of the 
four corners of the bounding box.  It should become a diagonal double headed arrow.  
You can now drag the signature smaller or larger.  If you want to constrain the 
proportions, hold down the Shift Key while you drag the box. 
 
Once you have the signature where you want it you can flatten the file.  Go to the Layer 
Menu and choose Flatten Image.  You can now save this file as a .jpg image. 
 
 
 
 
 
 


